The new multimedia functions inQuUAD 6 allow to analyze multimedia data with the sameepdures as text
data. Therefore, we will later describe these gdoces like coding or linkage analysis in detailtéxts as
data, and mention only additional options or exiogstfor multimedia data. These data files maysisirof
sound or audio data (for instance, tape recordestviews), video data (for instance, video recorded
classroom interactions during cooperative learnang) graphic material such as digital photographs o
scanned drawings (for instance, patients' drawafigjseir dreams). As most important advantageginesy
functions in AQUAD 6 help to save remarkable amounts of time and ynom& now necessary for the tedious
work of converting sound- or video-recordings itrtemnscriptions, nothing to say about avoiding theger

to loose valuable information in the process afdraibing them. Instead, you will now be ableteiafoding
your data — to move rapidly and exactly with a Ergouse click to any important event recordeddory
data.

Nevertheless it is possible and recommended tedrédre additionally some critical data segmentsieve
within AQUAD while you are analyzing your data. You may alsol amemos to code files related to
multimedia data. But you are no longer forced tuee, for instance, video-taped observations tavieh
ratings or descriptions. InQUAD you mark the beginning and the end of relevanissand add meaningful
codes. Afterwards you can analyze and retrievestiesnes with the same functions applicable tookebet.

However, before you start an analysis of multimetiita you may have to convert your data files into
formats, which RUAD is able to read — just as is the case with tées.fiHow to do this will be explained
in great detail in the following paragraphs. Ityare not familiar with multimedia in PCs, you niagl that
some of these procedures seem to require a leaafihg. But we can assure you, that after appliirse
procedures once or twice successfully to your owatadthe steps from an audio- or video-tape to a
multimedia computer file will appear almost selidenstanding and become a routine. In any caséintke
invested in learning is much more than compendat¢idne saved for the "real job" of data analyseause
you no longer have to transcribe your data.



Digital pictures and graphic files can be analyddctly in AQUAD. However, at the moment the software
is equipped only with a routine to import graphied which come in the format.jpg" — but any graphic
program that comes with scanners, digital cametasjs able to save (and mostly to convert, teaphic
files in this format. As basic rule for analyzipigtures and graphics inQUAD, please remember to save
them as

Jpg

files. Thus you can compress them and work withlsemsily manageable data files. Other graphiméds
like, for instance, *.tif or *.bmp consume much manemory space. Meanwhile practically all graphic
processors and most graphic viewers are able twecba great number of different graphic formats.
Therefore, we found it superfluous to inflate#ab unnecessarily by otherwise easily available cosigar
routines.

Graphic files are opened inQNAD following the same steps you are used from workiritty texts.
Maximal dimensions for pictures are 480 x 480 x#lyou try to files with larger dimensions, thietures
are automatically and proportionally adapted tcatvelable screen space. If you want to modifg Siarmat
or other properties of your graphic files, you wiilid helpful software on freeware pages in therdnét, in
CDs accompanying many PC journals, and on manyetsity servers.

We have good experiences with the program "Irfaw/iby Irfan Skiljan. For non-commercial use, for
instance, in scientific research projects, youaannload this program as freeware from

http://irffanview.tuwien.ac.atr
http://aranea.tucows.com/files2/iview380.exe



Audio recordings, which are stored in analog fosyat cassettes, records or other storage mediajrare
through a process of digitalization and converted & format computers can handle directly. Beedlus
analog frequencies on the original data carriercareverted into digital signals, this process itedaA/D
conversion. As hardware you need for this coneersi sound card, which is able to import audio data
through an "Audio In" connector (on most soundcéod8.5 jacks). This input channel should be ogunfed
with the parameters

44,1 kHz, 16 bit stereo

corresponding to CD quality. Modern sound cartifu#lll these requirements. Should your initaldio
data come from a DVD, you may need 48 kHz as sgttihich may be not available on older sound cards.
The manual of your sound card tells you about thesknical details. Just try an A/D conversion and
compare the quality of the digital product to thigimal recording. Many computer main-boards cavita
built-in sound chips, which are usually sufficiéot A/D conversions and later work withQNAD.
You import the analog data in most cases from a tigrk by connecting its "Line Out" jack with the
"Line In" jack of your computer. Import and consien are controlled by a software recorder, whimmes
on CD with most sound cards or can be found ontitisy CD (directory "sound", "audio" or a corresp
ding label) of your computer. If you do not owpragram of this type, it is easy to look for aniaugcorder
as freeware on the Internet. You will surely fonk and be able to save money.
By the way, an often overlooked possibility is &zord audio data (for instance, a group discussion)
directly with your computer. You just need to ceana microphone to the "Micro" jack on the souartc
or somewhere on one of the sides of your notebadkstart the software-recorder as described below.
Software recorders are basically handled the saayeas their tangible counterparts, i.e. usual tape
recorders. There is a button symbolizing a redend Just click on it with the mouse and pressrddve
"Play" key of your tape deck (or from which deveeer your audio data come). To terminate the tBogr
click on the software recorder's button "Stop" sade your digital audio file with an appropriaten®a You
will find this file then on your hard disk as ancampressed audio file with the extension "*.wavtied to
the name you have chosen for saving it. Howewar,should be aware that in this format

74 minutes (about a complete CD) of sound recordifigheed
about 650 Mbyte space on your hard disk.

The capacity of your hard disk for data transferuth be high (and even higher, if you want to dlgit
videos). If you notice errors, mostly tiny "holes' your recording, a slow hard disk may be the tmos
probable reason. We recommend to install a lazgarate hard disk, where you do not (!) install system
data or executable programs, but just your audid-védeo-files. However, even large hard diskshehe
limit of their storage capacity, if you analyze meaaudio-taped interviews — nothing to say abouewid
recordings. Therefore, digitized recordings shooédconverted from the originalavformat into the
common compression form&tP 3 (exactly: MPEG-I Layer 3). If you are familiar thiMP3-conversions,
just skip the following paragraphs.

The audio formaMP3, a development of the Fraunhofer Institute, alltevsompress audio files by a
factor of about 10 without reducing notably thaiatity. Conversion routines let you decide, wHeel of
quality and consequently how much storage spacevamt for your audio files. As an example,

a complete CD = 74 min play time contains
70 MB of sound data with a quality level of 128 kbfkilo bit per second).

This level corresponds more or less to the qualityegular CDs and is totally sufficient for sound
documents. You see, comparedN@d\tiles, MP3-files need about 10 times less disk space. Ifwork
already with an MP3-encoding program, just contitoiaise it for your AUAD project. Most of these
programs allow direct compression and recordiddi8without the detour of recording firstWAVformat.
Some sound cards come with software of this type.



If you do not have appropriate software, we recomurtee freewar®P3-program fameé' (laime ain't
no mp3 enocoder). You will find it in the Internetder

http://lame.sourceforge.net/

In the homepage d¢dmeare also links to graphic user interfaces (GUiklich support the handling of
lame(seehttp://lame.sourceforge.net/links.hdnY ou may also look for a Windows binary for commddine
operations and a GUI attp://www.mp3-tech.org/

Commandlame -h -b 128 inputfile.wav outputfile.mp3 (see figure below).

If you are not familiar with command lines, verwendjust apply a GUI with following settings:

CBR = constante bit rate; never (1) use VBR = vaediit rate for audio data, because all you
achieve are problems, particularly in connectiothwideo data.Bitrate = 128 kbp/s
file name = name of the initiWAVfile + extensionmp3

If you know how to work with command lines or bafibs, activatdameas shown in the figure below
(the root directory of AuAD in this example isE:\Demo_AQUADSG6 the initial sound file is
Demo_AQUADG6.wav, the compressed file will be Dem@QWAD6.mp3):

Depending on the speed of your computer, you wihsget aMP3file ready for playing directly (like
WAVfiles) in AQUAD. Then you can begin with your real work and aralyour audio data.
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If you want to convert video recordings, you haveonsider more details, but the procedure bec@mnes
routine, too, after a few repetitions. Principalle have to differentiate between

analoganddigital

video data. Probably you are familiar with anakideos, for instance, recordings in usual VHS rdecs
or VHS camcorders. Their products must be digitioe analysis in Auap. DV (Digital Video) cameras
produce directly digital recordings. If a DV camés available for your project, you should use ti@mera
in any case, because it offers some essential tatyes

e Higher video resolution (720 x 576 pixels in frélsolution according to the European PAL norm and
25 fps = frames per second, whereas VHS videos ooigavith 320 x 240 pixels or as S-VHS with 640
x 480 pixels); and therefore

e higher quality;

e only a minimum of preparatory work. Above all,afurse, you do not have to digitize the recordings.
The DV is just copied from the camera to your hdisk through &irewire connection (jacks usually
are available both in the camera and your computer)

e All you have to do is to compress the recordimgyfithe original DV format to the space-saving DivX
format.

» Video recording in the field is less conspicuond &aothersome, because DV cameras are small and
flexible to use, whereas VHS cameras are largejhead they produce recordings, which have to be
run first through a procedure called "capturinggr also compressed to the DivX format before you ¢
work with them in your computer.

Unfortunately, we cannot describe in this manuéhee how to handle recordings in the American norm
NTSC nor how to apply procedures like "inversedigle" or de-interlacing” often necessary in thisea
because we do not own and never needed NTSC cdpabeare. If you want to useQ8AD inthe NTSC
realm or if you have to analyze NTSC recordingsndrgre, please, read the information available & th
Internet pages listed below.

Video recordings consist of two components: thealctisual data, that is, the video stream, and the
corresponding sound data, that is, the audio str&epending on the type of your original recordiagalog
or digital) different procedures are necessaryafmlog recordings you need a two-step proceduriehw
treats both streams separately during the firgt, sted puts them together (called to "multiplexi®n in a
second step. The components of digital recordingprocessed (for instance, compressed) simultiahyeo

In both cases you need much empty space on yodrdisk until the compressed end product is
available. You may reckon on about 20 GB (GigaeBijtfor a 1%2 hours video recording in DV qualitg.
addition, you should have a modern UDMA-66 or UDNIBO hard disk and main board, which allow access
to the hard disk independently of the computer'$JCROf course, hard disk and main board must be
connected by 80-line UDMA cables, otherwise you numse data or even provoke the system to crash.
Processing of videos is a hard test of your comsutapacity to handle really large amounts of deddly
fast. But don't worry, modern PCs fulfill thesenrdds. In addition, you should take care that yidgo
files are written on a separate, empty hard disklisk partition, because only under this conditiba
complete file is written unfragmented or in onecgie To write and to read again the distributedrfirants
of a file consumes additional processing time — #re more fragmented a hard disk becomes under
WINDOWS, the slower it will work.

For practical reasons, the original video filesidtdoe converted into a less space consuming format
The reduction in quality of visual and sound infatian can be neglected, if we chose appropriatpeters
(details see below) for the conversion procedurasd-do not want to broadcast our recordings, halyae
them assisted by@uab. The audio component is converted to the folviaB (see paragraph 4.2), for the
video component we apply a codec nafad. Both components are reunited in WINDOW's vidaorfat
AVI. You can watch the final product, that is, A\él-file in AQUAD, but also with the tool "Mediaplayer"
that comes with WINDOWS.



Principally,AVl s just sort of a box or exactliwaapperformat that determindsowthe audio stream
and the video stream are arranged within the filéthout demanding explicitly which codec, thatikich
algorithm of audio/video compression you have foiyagt is up to you to make this decision. In thianual,
we confine ourselves to describing the combinatibMP3/DivX, because thus you avoid (almost) any
additional costs for software.

In the next two parts of this chapter (4.4 and wé&)escribe how to convert video formats stepéy s
and tell you, which soft- and hardware is necessé&iyst, we explain the conversion of DV to AVlifiv
compressions DivX/MP3). Then we describe the sama¢wmore complex conversion of analog (VHS) video
files to AVI files. How much time you will need gdends on the speed of your PC and its componerttss|
respect, quantity — here the CPU's speed exprésgeldz, memory and hard disk capacities — realbnis
advantage, particularly if you "capture" analogadgd and if you apply compression codecs (like Divifjer
converting your data, you can burn all audios/veden CD or DVD, but watrongly advise agains{(!!)
analyzing these data from CD or DVD imBAD. During this work, you will over long periods a@ifte listen
to or watch the same scenes again and again angacerthem with some similar or related scenes,ishat
the CD/DVD drive has to read short data segmentaraius locations on the disk surface again amihag
These drives, however, are built for continuouy plad wear out much faster then expected, if yeuthsm
for "stop-and-go" data traffic. Therefore, you sldoanalyze your data from the hard disk and apfihg Gr
DVDs only to file away your data for security reasqwhich is strongly recommended!).
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As hardware equipment you need:

* aDV camcorder;
e inyour PC a digital video card with firewire (IEEL394) connector
or simply a firewire jack (if necessary on a sepafaewire PCl-card);
e ahard disk (at least UDMA-66) with a minimum df GB free space (for 1% hours video data)

In addition you need the following software tools:

e aprogram to handle the firewire functions of yB@. If you have built in a separate card, libea
with this software. Any software video editor aff¢he necessary functions; you plug in the firwire
cable from the DV camera, click on the video edtdmport" button —and your computer manages
the data import from the DV tape in your camera).

e Virtual Dub (Freeware under the rules of GRttp://www.virtualbdub.or}

e DivX Codec, at least version 4.12 or 5.0.2 (freleatewarehttp://ww.DivX.con)

* lame mp3 encoder (lame ACM file — thiguist the Win32 Binary described above). This software
is available (download) at
http://www.afterdawn.com/software/audio_softwarellauencoders/lame_acm.cfm

(This link is not underlined to kettye " " characters visible).

If you work with WINDOWS 98/98SE or WINDOWS 95 g#aead now the digression "WINDOWS version
with the file allocation system FAT32."

We do not describe here how to handle softwareovéditors or firwire cards, because there are tayma
versions and variations available. Please, reathdreial of your firewire or video card and/or vidsitor
program how to transfer video data from a DV cardeoto the hard disk of your PC. As mentioned above
it takes nothing more than plugging in the cahlétching on the camera (in VCR mode), and clickivith
the mouse on a button. Do not push the "Play" budtoyour camera - this is done virtually by thégare.
Fundamentally, to transfer video data means to tlogy from the camera to the hard disk; therefibis,
procedure takes as much time as the original reggahd does not delete anything from the DV tapee
resulting copy on your hard disk has the format A\jut was compressed by a specific codec useleby t
DV camera and consumes much more disk space tin@céssary for the quality of video data for arialys
The same is true for the audio data in the regul¥I file. That is why we continue the preparatsofor
analysis by converting both data streams togetttera less space consuming format.

Now it is time to install the DivX-codec, which ydiave downloaded from the Internet (address see
above). Double click on thexefile and follow the instructions of the installati routine. There are no
decisions necessary, just accept the default gsttin

" /

The second codec neededl@ie’ (see above). You have to unpatkti€’ (it comes aszipfile) and install
it. Among the unpacked files you will find one neariLameACM.inf' which organizes the installation of
the actual toollameACM.acth You click with theright mouse button on thigf file (for instance, within
the WINDOWS Explorer) and then within a small adudial context menu on the optiomstall.” That is
all you have to do. If there is no error messtayagis available for further procedures.

Now we can start the conversion software VirtualDiihis software is just copied into an appropriate
directory — you need neither to install this softsvaor any of the various additional plugins. Hoer the
specific DV codec for your camera must be availablgour computer, otherwise VirtualDub cannot open



your video recording. Usually this codec was alydastalled automatically, while you installed #udtware
video editor that earlier copied the DV from theneaa to the hard disk. If VirtualDub complaingame
cases that it is unable to open your DV, you havesdtall the missing codec manually. There arg arfew
DV codecs in use and it is easy to find them inlthernet, most probably on the pages of the marwrfer
of your DV camera.

Here now are the steps that lead from the copgwf yideo recording on the hard disk of your coraput
to a much smaller AVI-file ready for analysis iQBAD:

Start VirtualDub by double clicking with the left
mouse button on the file nardé&tualDub.exeand
open the initial *avifile by clicking on

-> File
-> Open video file

£ ¥irtualDub 1.4.13 - [Demo_AQUADE_2ndpass_szenel.avi]
File Edit Video [Audio Options  Tools Help

Then get access to the audio stream of your DV

by selectin
Conyersion, . Chrl+-4 y 9
Interleaving. .. Chrl+1 .
Compression. .. -> Audio
Volume, ..

Mo audio

OO — > AV audio
Wav audio. ..

& Direct stream copy
Full processing mode

£% virtualDub 1.4.13 - [Demo_AQUADE_2ndpass_szenel.avi] o . . )
Fle Edt Video | Audic Options Tools Help and initialize its conversion by selecting

Cony T i

Interleaving. .. Chrl4I -> Audio

Mo audio
® AVI audio
WaY Audio...

® Direct stream copy 3
ing moh -> Full processing mode

For the audio compression you have to select aiv aodlec, in our cadame With the mouse button you
mark

£E ¥irtualDub 1.4.13 - [Demo_AQUAD6_2ndpass_szenel.avi]

Fle Edit Video | Audic Options Tools Help -> Audio
Conversion. .. Chrl+a
Interleaving. .. Chrl+1

e s -> Compression.
Wrlime




In this following window you select
in the left box the encodet.&me
MP3' (or "Lame MP3 encoder

(ACM)").

In the box on the right side you
click on the settings44100 Hz,
128 kbps CBR, Stereo

If no settings are visible in this box,
just mark the check boxShow all
formats"

All done, you click on the OK"
button.

To activate the conversion of the
video stream, select now

-> Video

-> Full processing mode

If you want to change the screen size of your
video, that is, if you want a smaller picture oa th
screen (enlarging is not worth while, because this
is done only by adding interpolated information;
thus you do not see more details, but you need

much more disk space), you go to the "Filters"
section and start by selecting

-> Video-> Filters,

then

-> Add

-> resize
and finally

-> OK.



Of course, we have to determine appropriate ssttiog
for width and height:

Here, the values (pixels)

-> 320 and-> 240

were entered. In addition, the conversion algoritlamto
be selected, here

-> Precise bicubic (A=-1.00)

Just select the same procedure.

At the moment AUAD reserves screen space for video dimensionsaafmally 480 x 480 pixels (In

preparation: 720 x 576 pixels for screen resolgtigreater than 1024 x 756 pixels).

What is left to do now is a mouse click on the
OK button.

In case you see more or less large black margins
around your video when you play it, you could
choose the function

-> Cropping

Cropping eliminates superfluous parts of the
picture, for instance, those black margins, which
also need storage space on the hard disk. Look for
a light video frame (no black margin areas within
the picture!) by moving through the video with the
slide control below the picture and adjust the
margins. Finally, you confirm your settings by
clicking the 'OK" button.

Now we are ready to compress the video with the
DivX-codec. First we select

->Video
-> Compression

then we decide about an algorithm for com-
pression:

-> DivX 5.0.2 PRO Codec
and click on the button

-> Configure



The computation of the new version of your videaetatwo steps.You find details in the digression
paragraph "The DivX codec" (chapter 4.6 o explain some of the following settings in adee, we
describe here only the meaning of "key-frames" widao:

During compressing a video, the codec determinaagds between each single picture (“frame") and
its preceding frame. Only information about changesaved, not the unchanged parts of the picture.
However, from time to time the codec saves a comagtame again, the so called key-frame. These key
frames are necessary, if we want to jump direotly particular scene, for instance, when seleeticude for
replaying the corresponding video sequence: Thgram can jump directly only to key-frames — arld al
other pictures have to be reconstructed from tfeerimation about differences/changes, that is, thagt be
computed. This means waiting, particularly if anputer is not very fast. The default setting ofXi
therefore adds a key-frame every 12 seconds (=frad@s). This is not sufficient for smooth scrrudji
through a video and for differentiated coding. ¥eommend to place a key-frame twice per secordabr
25 frames/second — to save eacli ft8me as key-frame. Of course, the compressithuis less efficient,
but you do not get annoyed and waist time for wgitvhen you are analyzing your video.

In the DivX window you select first
-> General Parameters

(click on the second tab) and enter

the recommended key-frame interval of 13 frames:
Max. Keyframe interval = 13
None of the other settings must be changed.
Then you click on the first tab (upper left cornédjvX Codet
and adjust the details for a first and a second petation run
(first/second pass) as follows:

You select here

-> Variable Bitrate Mode
-> 2-pass, first pass

Below you enter names for log-files. It makes sdnaise always
the name of your video, but to attach differeneagtons and to put all
files of this video into the same directory, fostance:

for the log-file  -> Videodatei.log
for the MV- file -> "Videodatei.log.mv

Then you determine the bit rate of the new video;
an adequate setting would be

->1200 kbps



Original recordings of good quality (like videosrfin DV cameras) lead to good results even witraipés
between 900-1200 kbps, while low quality analogrdimgs never make up for initially missing detdiis
high compression bit rates!

After confirming your settings twice by clicking dine 'OK" buttons in these windows you come back
to the start screen of VirtualDub.

Back in the VirtuelDub window you have two
possibilities to continue: Either you press e
key on your computer keyboard or you click in the
VirtuelDub window on

-> File
-> Save as AVI

Enter a name ("name.avi") for your video and
mark, whether you are determining the settings for
the 1stpasoor the2ndpasqsee the alternatives in
the selection box).

In both cases you must not forget to markwiée checkboxbelow the field, where you entered the file
name of your video; the checkbox is labeled difidlye depending on theversion of VirtualDulRdn’t run
this job now; .. or "Add operation to job list ..

If you forget about this checkbox, VirtualDub wtart its job immediately — whether you have set
already all parameters for both runs or not.

After entering the settings fastpassn VirtualDub, you return to the settings of Diy3ee aboveVideo
->Compressiopand selecendpassDo not change any other settings, above all,atonodify the names
of log-files, just select

-> Variable bitrate mode> "2 pass, second pdss

and confirm your settings by clicking on "OK". Trhgou save (see above: F7 oBave as AYlthe name
for your video in the second run, for instance @anie-2.avi." Again you must not forgetrmark the
checkbox"Don't run this job now..." or "Add operation to job list ... Finally you confirm all settings with
"OK".



Now at last you can have your computer producealsm
version of your video.

Select
-> File, then in the lower part

-> Job Control(or press th&4 key).

In the following window (see below) you mark thesfiof the two jobs listed therédb 1; ..._1stpass.avi
— then name depends on what you have enteredrgariie click on "OK". VirtualDub starts its worke
converts automatically your video in two runs.

Depending on the speed of your PC you have to avaitile, because the complete video is now
processed two times. If you work with a slow PQs & good idea to start the whole process in teaiag
and get the compressed version of the video reasymorning.

New CPUs (speed > 2 Ghz) are able to process AVesil time or even faster. If other processeghwh
need much computation, are running at the samedimgour computer you will need much more time.
Therefore, you should rusnly the conversion job on your PC — particularly beseaa crash of any other
program could interfere with the conversion jold gou would have to start it again from the begigni

After VirtualDub signals that it has finished batims, you can try to open the final product (2ndpas
with WINDOWS' MediaPlayer. If there are no problertigat is, you see your video and hear the sound
synchronously, your recording is ready for analyrsi@QUAD.



As an alternative you can select in the DivX
window the possibility to convert the initial video
in one step only:

-> Variable bitrate mode
-> "1st pass

While you gain time you probably lose quality
and compression, that is, you need more disk
space, because there is only one computation run.

If you want to experiment with codec settings, ghould confine all conversions to a maybe 2-minute
scene from your video and try various settingslogips of VirtualDub {> Video -> Filters cf. above:
"resiz€). You select, for instance, the first 3 min & ®f your initial video by marking

-> Video -> Select Range

Within the settings of Frame$ you enter a video
segment from frame 0O to frame 5000 (which corredpon
at a rate of 25 fps to 200 seconds). Confirm teefngs
by clicking on "OK". Your original video is kept
untouched, but you get in a short time a short Adfby,
which demonstrates the effects of your filter stders.
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Analog video recordings also contain video- andiawstreams, which we have digitize both. There are
several different scenarios how to achieve thesgarsions necessary for data analysisQuAp. In any
case, you need the following hardware equipment:

* much memory (RAM) space — at least 256 MB or more.

» afast CPU (for software MPEG-2 encoding at 1€8st - 1,3 Ghz Pentium Il or AMD Athlon)

» afast hard disk (at least UDMA-66) with much sipe capacity (for transferring the initial recoiglin
from the DV camera to the disk you should reckoti20-30 GB disk space for 1¥2 hours, depending
on the camera's codec).

The "capturing" itself, that is, the conversiorpidligital format is realized in a special capturaagd,
which must have a "Video IN" connector for analaeged Most of these cards process the audio stveam
the "Line IN" jack of the sound card in your comgaut Details were described in paragraph 4.2 (seeq).
The conversion scenarios differ — above all in eeahmoney — depending on the features of the dcagtu
card. Principally, you dnotneed an expensive video editing card but onlyeaphr TV-card, if all you want
to do with your videos is analyze them ip@aD. You should differentiate between three possibdi

(1) TV-cards to watch television on your PC
They are relatively cheap and include usually capdufunctions. However, the compression rate is no
the highest, therefore the digital product consumash disk space — but big hard disks are nevexthel
much cheaper than video editing cards, which coritle there own chips for encoding (hardware
encoding). An overview on hardware necessary faodimg with VirtualDub is available on the
website of VirtualDubhttp://www.virtualdub.org/docs_capture

(2) Graphic cards with Video-IN connector
If you are about to buy a new computer or graphidcthis is a clever solution, if medium qualifyiee
resulting digital videos is sufficient — which imi¢ for the analysis in @uap. You should be aware,
however, that there are various chips for graphids. These chips mostly convert the analog vidgati
into a digital output by applying software codecsading to the MPEG-1 or MPEG-2 norm (which
needs very much computations; CPU >1 Ghz necesslig)ally you find one of the following chips
on these cards: Rage Theater from ATI, the new IS5 ftom Philips or a Brooktree chip, which is
already somewhat longer on the market. You finchiteet information on the homepages of the
manufactorers of graphic cards or of computer jalsn

(3) Video editing card with analog (and digital) oeator

This solution is the most expensive of our threggestions, but guarantees best quality. Howewer, y
must keep in mind, that a digitized video can ndesbetter than its analog source. Do not believe
miracles, even if some plugin filters promise togamiraculous effects. If the source framesate
of focus, blurred or otherwise technically poorpemsive digitizing hardware does not offer much
advantages over cheaper software solutions — egpept. As time is money, the higher costs ofovide
editing cards will pay off in a research projedhane you have to capture many analog video recgsdin
Of course, if you need semi-professional qualitydther reasons than data analysis, an editingisard
your choice anyway.

Some of these cards have both analog and digitedemiors, which really enhance the options for
further elaborations. In addition, cards on thisglevel come with semi-professional editing waite,
for which you will have to spend a lot of moneyydu buy it separately. However, in our opinion
usually it is worth wile to buy a video editing dawnly if you have more in mind with your recordéng
than analyze them.

As to speed, video editing cards have built-in elecachips (hardware encoding), which produce
in real-time a MPEG-2, MPEG-1 or Motion-JPEG (M@Ecompression of your video. How to
operate these cards is described in their speudicuals.



In case you have a video recording encoded in MREgB-your hard disk (for instance, after
capturing an analog video source with a TV- opbie card), please read the paragraph on "MPEG-2
as source data" (within paragraph "4.5.2 Captwiagyraphic card with Video-IN entry and software
MPEG-2 encoding").

To support your decision-making, we add a list®f guestions:

* How much money are you able or willing to spendyfour project?
*  Which quality and format (analog/digital) do yadnitial videos have?
* Do you want or need to do anything else with ywideo recordings than capturing them?

Subsequently we describe the scenarios (1) anfdr(®)deo capturing in detail. Please, get add#ion
information in the Internet. You will find amplaformation about the topic of "video capturing"nvany
guides and tutorials. In this manual we cannotndoe then outline some standard procedures. Telau
off your search for more details, we selected sofitiee many web sites, which we found to be hejghdre
you will find downloads, guides, tutorials, howttinks, and tests:

* http://www.virtualdub.orghomepage of Virtual Dub)

* http://www.google.dgsearch engine, enter for instance "virtualdub wampg")
* http://www.doom9.orgguides, downloads, large list of links)

* http://www.vcdhelp.confguides, howtos, downloads, tests)

* http://www.slashcam.d@bove all about DV)

* http://www.DivX-digest.conm(guides, howtos, hownloads)
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You need this software:

1. VirtualDub fttp://www.virtualdub.org)

2. huffyuv codeclittp://math.berkeley.edu/~benrg/huffyuv.hfml

3. lame ACM code¢http://www.afterdawn.com/software/audio_softwarellauencoders/lame_acm.cfm
4. DivX Codec [ittp://mww.DivX.com)

The cooperation of VirtualDub and your TV-card viilhction only, if your card is equipped with a VW
("Video for WINDOWS) driver. If this is not the sa, there is a work-around applying WMD drivers.
However, there should be no problem to apply ViBub, if your TV-card has one of the chips based on
Bt8x8 by Brooktree. (The homepage of VirtualDubatées some difficulties with the new SA71xxx chip
by Philips, and offers a work-around for these fepts). Information about cards supported by Vi,
WMD drivers, and a tutorial are available on thdvsée

http://btwincap.sourceforge.net/

WDM drivers give access to TV-cards from within tdalDub. In
addition, they work as wrappers for VW drivers gs&bove). The
procedure of capturing via TV-cards may sound neoraplicated than
it is; just start VirtualDub (click onVirtualDub.ex&) and mark the
following options:

-> File

-> Capture AVI
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The fact that no error message appears after demdelick (‘Capture AVI) confirms: VirtualDub is
able to locate and to contact the drivers of yourcard.

In case of converting analog videos, you shouldrdoad the free codec HUFFYUV from the Internet.
The HUFFYUV codec is a so called "lossless" codbat is, it converts without loss of information.
Compared to the DivX codec it demands less comipuatatork, but in exchange it consumes much di9sk
space (lower compression rate!). All settingsd®scribed excellently on the homepage of the dpeeto
Please, consult their pages, if you have any questivhich could not be answered in this short duabion:

Installation:http://math.berkeley.edu/~benrg/huffyuv.html#Inistébn
Capturing:http://math.berkeley.edu/~benrg/huffyuv.html#Cajptgr

You install HUFFYUV by unzipping the .zip file, ck with theright mouse button on the file name
"huffyuv.int and select the optionristall.” Afterwards, HUFFYUV is ready for work. The deit settings
of the codec match the demands of capturing viecdkd — so do not change anything. However, we must
determine some parameters in t@aptureé’-dialog of VirtualDub. We start by entering nanmedocation
of the video file that we are going to convert:

-> File
-> Set capture file

Attention: If you work with WINDOWS 98/98SE
or WINDOWS 95 and these versions' file
allocation system FAT32 (cf. digression
"WINDOWS version with the file allocation
system FAT32") you mark instead

-> File -> Set striping system

and enter then the main name for the file
segments.

Then you move on in the main menu to

-> Capture

-> Capture drives



and mark there (also in the function group
"Capturé)

-> Capture

-> Enable multisegment capture

As settings for the compression of the audio stream
you mark first

-> Audio
-> Compression

and enter in the appropriate slots

"Format": ->PCM,

"Attribute": ->44.1 kHz; 16 bit Stereo

Then, after marking

->Video
-> Compression

you select for the video stream the codec named
HUFFYUV. You can accept the default settings
without any problems.
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Now you have to decide about the size of the
resulting video frames (number of pixels for width
and height). You mark first

->Video

-> Set custom format

In the list of custom settings you select
"352' x "288'

and

"YUYZ2 or "UYVY."

Then you move on to ...

-> Capture

-> Settings

where you enter "25.0000" in the field labeled
"Frame rate:".

To test all these settings you push now the "Hiayton on your video recorder, activate the sofesar your
TV card and select within the TV menu the apprdpréhannel for your recorder.
Within VirtualDub you mark

->Video
-> Preview
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If the computer screen shows now the video and
you can hear the sound, then your settings are
perfect and you may stop the preview run. For the
real conversion, we recommend that you mark

-> Capture
-> Hide on capture

Otherwise the video is shown during the conversion
—which wastes computing capacity and slows down
the whole process. Remember: With this setting
you donot see the video, while it is captured.

Start the capturing process by marking

-> Capture
-> Capture video

If you are capturing the first of your video tapiéss a good idea not to capture the whole filg, dnly a few
minutes and to test the resulting AVI-video in IWeNDOWS media-player. You can stop the capturing
process any moment by pressing the ESC key. Ifayeusatisfied with what you see and hear, retirn t
VirtualDub, rewind the video tape in your recorded start the capturing process again. This tiowelgt
VirtualDub complete its job. This testis necegsanrly once, when you have determined the varietisgs

for the first time. If you do not modify any setlis, you can be sure that all the following tapescaptured
successfully, too. Please, refrain from running @er jobs on your PC while you are capturingdee,
because parallel tasks could cause "frame-losgimgitting of frames), and consequently pictured sound
would be less and less synchronized.

Once the capturing is terminated you have a HUFF¥debded video with uncompressed audio stream
on your hard disk. All you have to do now is to ert this file into an AVI file that contains DivKIP3
compressed video and audio streams. In paragrdptiéw to convert DV to AVI (DivX/MP3)" we have
already described the steps of this procedure.
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The procedure depends on the graphic card an@gtering software, which came with this card. HEfiere

we can only recommend to read the manuals anddlgpowrhich should be delivered together with thagpdpic
card or are available from the manufactorer's stpgpeges on the Internet. However, we can giveesom
generally valid advice as regards software settiogsideo capturing:

* In case you capture a VHS recording: dimensid&@x3288 pixels at 25 fps
* TV norm (Europe; Germany): PAL-B

» Compression: MPEG-2

* Audio: 44,1 kHz, 16 Bit Stereo

Most graphic cards with Video-IN facility are bufittr close collaboration with the CPU of the congaut
As a matter of fact only the A/D conversion fronakmy to digital format is done on the card, while work



of encoding is carried out by the CPU. Again, sbeed of capturing depends to a large degree an you
computer.

You may think about choosing MPEG-1 encoding aaltemnative, which is offered by some capturing
cards and their software. In this case, howewar,shouldhot convert to AVI format, because on the one
hand these AVI files can be read often only by tenufacturer's software and on the other hand the
manufacturer has prevented that we apply otherasotike DivX, for instance). The solution is — ke next
paragraph — to convert the MPEG file afterward&¥ in an additional step.
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If the format of your video sources is MPEG-2, ymed the following (free) software for converston
standard AVI, which can be run inglAD and other programs:

e VirtualDub (http://www.virtualdub.org)

e DVD2AVI (http://arbor.ee.ntu.edu.tw/%7Ejackei/dvd2avi/

e VFAPI Plug-In fttp://mww.doom9.org/software2.hjre> Sektion "Support Utils";
(There is an alternative, however, in Japanesaibaggonly:
http://mww.yks.ne.jp/~hori/VFAPICodec.htinl

e DivX Codec fttp://mww.DivX.com)

* mp2wav {ttp://mukoli.free.frimpa2way/

* lame ACM Codec
(http://www.afterdawn.com/software/audio_softwareiauencoders/lame_acm.cfm

You prepare these software packages by

(1) installing the VFAPI plugin: you un-zip the filmto a directory like "VFAPI", open there the
subdirectory "Codec" and start (by double clickivith the left mouse button) the fileifpset.bat in
this subdirectory.

(2) In a second step you copy the figkFAPIConv-EN.exXe which you will find in the subdirectory
"Reader" of the un-zipped VFAPI plugin, to the systdirectory of WINDOWS ( folder "system32").
The exact path is

"%SystemRoot%\windows\system32" in Win9x or
"%SystemRoot%\winnt\system32" in WIDOWS NT/W2k/XP.

This directory is part of WINDOWS' global variat#®ATH. Therefore, the binars/FAPIConv-
EN.ex& can be called directly from this location withcadding each time the complete directory
information.

(3) As third step you install the DivX codec. How do this is described below in a paragraph titled
"Digression: The DivX codec."

(4) Finally you copy the binarytfipa2wav.exegrom its .zip-file into the same folder ("syst&2") to which
you have already copied the binakFAPIConv-EN.exé

VirtualDub and DVD2AVI need no installation. Theyegust copied to the hard disk and can be started

directly. That's what we should do now: Start DVDAAand open the MPEG-2 encoded video file by
marking

-> File
-> Open

in the main menu.



If the following window does not offer any video
files for selection, your video obviously was not
saved with one of the (obligatory) extensions
".vob", ".m2p", ".m2v" or ".mpv". In this case
you should either rename your video or select in
the slot "File type" the option

->"All Files (*.*)"

Now the name of your video will appear in
the file list and you can finally select it. Comfir
by clicking on "Open", afterwards on "OK". If
you want to convert more than one video, you
select "ADD".

You may wonder why some of the screen-shots shawa@dabels. Well, on our PCs the German
version of WINDOWS is running, and if the softwdescribed here calls standard WINDOWS routines
like above for opening a particular file, the saneshows these routines of course in German, eveeyif
are called by programs in other languages.

Move the slide control to scroll through your vidaed
getan overview (however, without sound!) on itstent.

You may test it fully by marking

-> Optionand

-> Preview

A separate status window on the right side of thallsvideo screen should show the following pararset
(supposed you preview a PAL-Video):



Video

- Frame Rate: 25.000 fps

- Frame Type: Progressive

(instead you may read "Interlace”; in this caseapé
read the digression "De-Interlacing” and apply the
corresponding filter in VirtualDub).

Audio
- Format: MPEG Audio

Normally, the default settings of DVD2AVI are
completely correct. However, you should check, \waet

the following parameters appear in the video ardicau
sections of the main menu:

-> Video

-> Color Space
"YUV 4:2:2"

-> Audio

-> MPEG Audio
"Demux All Tracks".

In addition, in the section
->Help the option

-> VFAPI Plug-In

should be marked by a tick {.

Then you save what we have got until nogt as AVI
(1 By marking the appropriate option in section

-> File

-> Save Project



As file name you enter "file-name.d2v." Of counga could directly convert into AVI in DVD2AVI,
but unlike VirtualDub, you are offered only veryf@ptions to modify the default settings. Thawtsy we
describe here only how to work with VirtualDub.

A status bar shows the progress, while DVD2AVIrssating two project files with the following name
extensions:

» .d2v (contains the information about the videeain)
* .mpa (contains the information about the audiesstr = MPeg Audio).

What is left to do is to convert finally the *.dB&ile by applying the VFAPI routine for conversiiomo
a format, which VirtualDub is able to read:

Start the program "VFAPIConv-EN.exe". Click Click the button
-> Add Job

and look for the just created *.d2v file.

If you cannot find it, even though you are lookfogit within the
correct directory, you should check, whether thtoop

-> File type (here: Dateityp)

is set to "DVD2AVI Project File (*.d2v)" and theldi
which you intend to open, has a hame really endiily
the extension .d2v.

After successfully opening the file, click on
"OK" in the next window and mark then the option

-> Convert

If there is no error message during the creatidgh@fVI wrapper file, everything worked fine anaduy
can exit this program. Do not wonder in case seratic characters appear on the screen. Therdilire s
some messages from the original Japanese verfianéeyour computer may not be equipped with Japan
fonts. Don't worry — the video will work neverthete

VFAPIConv-EN.exe has now created an AVI-wrappetlichviallows to open the file *.d2v like an AVI-
file directly in VirtualDub. This file has the etision "d2v-vfapi.avi." However, we have to caosvrfor
the audio-stream and convert then MPEG-audio (*.Hips into the format WAV, because that is what
VirtualDub expects. The necessary steps aresignilar to what we have already done when convgttie
video stream. There are various alternatives vemaill describe two of them: There is a freewandia
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editor called "Audacity" and the universal tool &hedit" for handling DirectShow filters. You can
download a beta-version (in the moment — June 20@4rsion 1.2.0-pre3) of "Audacity" from

http://audacity.sourceforge.net/

You should not worry about the stability of thiseth" release — it proofed to work fine, at leastdor goal

of converting video material for analysis i@Bab. On the homepage of you will find many hints, hiow
achieve MP3-compression with Lame (see above) mwithidacity. The software is available as a self-
installing "exe"-file or as a ready-made "zip"-file

http://audacity.sourceforge.net/latest/audacity-gipn php/audacity-win.zip

which you download, unpack - and start (withoutatiation procedure
and maybe a re-boot of your computer). On yoweestryou will see
the following:

Click on
-> Open

and look in the next window for the file with thetension "mpd,
which was created by DVD2AVI:

In case you cannot find such a file,
just select All files (*.*)" in the
slot labeled File type!

Then you click on the button
"Open" Audacity will create a
safety copy and start to scan your
audio file. This may take some
time.

If the whole operation was
successful, you will see in blue
color an oscillogram of the sound
file. Itis absolutely sufficient then
— unless you want to convert this
file into MP3 format — to select
then menu option

-> "Export As WAV.".

and save the file under the same name, but witextension wav" The
above mentioned settingPCM, 16bit Stereo, 44,1 Khis the default for
WAV exports in Audacity. Therefore, you do not baw select or change
anything.
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While Audacity is working, you can see the progress

After exporting the file, we close Audacity agaien we open the new (WAV) file again in VirtualDub
and start the encoding to MP3 there. In order toicayroblems of synchronization audio/video we
recommend to encode the sound file to MP3 formbt after exporting it as WAV file into VirtualDub.

Continue now to read how to work with VirtualDubgaragraph 4.4.2 "How to work with VirtualDub"
(see above). Make sure to select the adequate £eddaivX for the video and LameACM for the audio
stream — and settings. Save the AVI file as 1stpad<2ndpass jobs (see above). Then you starirshef
these two jobs and wait, until your AVI file is cphated automatically.
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Graphedit is a tool that allows to combine any Bti&ow filters (= DS-filters), if the output of tpeeceding
filter is a matching input for the succeeding filte the filter is able to process the file (audiioleo), which
was attributed as input. Initially, Graphedit veeveloped by Microsoft; however, the download iglita
find on Microsoft's internet pages. We suggest, lyave a look athttp://www.doom9.orgjor you enter the
keyword "graphedit” in a search engine liketp://ww.google.dg thus you will find the necessary files
without difficulties.

In the following we will describe how to apply Giagit. You may get the impression that this sofewva
is somewhat demanding. However, Graphedit workiepty, for instance, when it comes to convert MGRE
1 Layer Il sound to WAV or if you want to have %11 Dolby Digital Sound for movies on DVD.

Before we start Graphedit, we have to make sutétthdl get access to MPEG-2 DirectShow decoder
filters. Here we demonstrate the procedure wihuersions of these filters available on the weegaf the
company Elecard:

http://www.elecard.com/download/

What you need is the packadeMpgDec20_mpeg?2_videodecoder.zidbownload this file, unpack it and
start the unpacked "*.exe" file. Thus, the filteuif become installed on your PC and Graphedit gl able
to apply them.

After downloading the package of Graphedit file®,) also have to unpack it first. You will find ief
labeled teadme.txXt (or a file with a similar name), which explainsvinto install the filters. Please, read this
file carefully and follow the instructions. Usualthere is a file "register.bat" in the packageicllorganizes
the installation of all filters that come with Glagalit. Just double click on this filename.

Finally we are able to start Graphedit. Go to tlemgroup
-=> "View'

and select the option

->"Autoarrangé

to erase the mark in front of this option.

Otherwise, Graphedit arranges automatically ther§ilon the screen —
sometimes moving a filter box beyond the screerddasr and leaving us
without exact information about which filters anepéed at which stage of
conversion.

Then we move on to the menu group &réph’
and select there ->Irisert Filters."

The following window will appear:

We click on
-> "DirectShow Filters'

because here are we find all DS filters, thahis, t
downloaded Elecard filters, too.
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First a summary of the steps, which follow: We tstar opening the MPEG-2 encoded file, then we
separate thee audio- and the video stream. The attdam is then decoded, converted to PCM andtgo
as WAV file. Finally, both streams are written bawto a file, which can be opened later in VirtualD

Whenver we select a filter in Graphedit, a smab kdth this filter's name appears on the screen. We
connectfilters, thatis, we organize the encodiageding processes by clicking on the "output" efdefilter
box, keep the mouse button pressed and draw #olthe “input" side of the next filter's box. Let start and
open the MEG-2 file:

As filter we select

-> "Elecard File List Sourcé

Then we do exactly what the window headline says:

We look for our MPEG-2 encoded file (here
"Demo_AQUADG"), select it and click on the
button "Open" (here: "Offnen");

Next we select as particular filter

-> "Elecard MPEG2 Demultiplexér

This filter will separate the audio stream and the
video stream in our file. That is why the filtenbo
appearing on the screen has two outputs — one for

audio and another for video information in our
file.

To decode the MPEG-2 audio we insert (by seledtim the list) the filter
-> "Moonlight Odio Dekoda

and connect the input of this filter's box with thedio output of the preceding
box of the "Demultiplexer."
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All that done we can leave the section "Direct Slidlters" and move
onto

-> "Audio Compressors

where we select

->"PCM."

Connect again the input to this filter and the ouitd the preceding filter. Then we go back togbetion
"Direct Show Filters" and determine there a dediim filter:

-> "WAYV Dest'

Finally, we have to select

-> "File writer"

to make GraphEdit write a WAV file as output. e tdialog box, which
will appear next, we enter a file name with thesegion "wav"

What is missing now, is to tell GraphEdit to operatcording to the steps listed graphically on the
screen. This sequence of operations is called "pldlgerefore we click in the upper icon bar ongiimbol
for "Play." . Here is the complete display of graphically repreed commands:
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GraphEdit will need some time to accomplish alktheperations.
During this time, the "Play" icon will be "blendedt" and appear in
gray color. Once the color changes back to bl&iaphEdit has
finished its work and saved the audio stream inf\Mile.

We should check whether the quality of the new daiile is acceptable. With a file manager, for
instance, Windows Explorer, we search the nambeofile and start it. Usually, the installatiortseys of
WINDOWS link *.wav files and the MediaPlayer. hig case, double clicking on the file name wilieate
automatically this player software and start thenskfile. If not, you should activate an audioygliain your
PC and open from within the player's menu (usudilifes" -> "Open") your new *.wav file. If youkde what
you hear then, the work with GraphEdit is finished.

By the way, you do not have to construct the graphkages of filters for each file anew, but yoayn
save the linkages as XML file or in GraphEdit's darmat. However, you have to determine the fdees
within this construction for each new file. Thisaichieved very simply: Mark a DS filter and priggsDEL-
key on the keyboard; then you can enter a new name.

Principally, there are various ways how to link filers — just test some combinations. The Elecard
filters in our example armot freeware, but you have to buy them, if you wanapply them seriously.
However, there are many alternatives: Often thessary MPEG-2 decoder filters are integrated in DVD
software players and in video editing software,clihiome mostly on CDs added to graphic cards, video
editing cards or firewire cards. GraphEdit offdrsse filters for selection, too, if they can berfd in your
PC (see above, p. 59). The menu section "DS FiliebraphEdit gives you an overview on filterseady
available in your system. What you need is

* a MPEG splitter (= demultiplexer) that splits MM®EG stream of your video into an audio component
and a video component (on the Internet, you cah for instance, the LIGOS MPEG Splitter);

 aMPEG audio decoder (integrated, for instancthérsoftware from Intervideo or Cyberlink for DVD
players);

All the other DS filters, which we applied in theagnple above, come either with GraphEdit or they ar
already installed in your PC (see above). In gasdack one of the necessary filters, it wouldilgod idea
to install a test or demo version of some videtimgisoftware or DVD player software, becausesbiware
will automatically install the necessary filterept Although this software will work only duringe test
period (mostly 30 days), GraphEdit may still getess to these filters afterwards.
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The DivX codec can be traced back to a cracked cdoe WindowsMedia by Microsoft, which was
distributed on the Internet under the name "Divdalpha." Afterwards, in a project "openDivX" a
proprietary, absolutely legal codec was developdich you can find on the website

http://mww.DivX.com
in to versions (actual version no. 5.0.2)

« as freeware with limited functions, and
» as shareware with full functionality.

If you download the shareware version, but do itivate it, that is, if you do not by a licence ayet an
activation key, the codec will work, but as "adwar@ his means, that the software tries to fincetnet
access, to connect your PC to its own server aslddw advertising banners (therefore the name "a@-y

on your PC. These banners have to be downloadleducse, and they cost CPU resources and — itlgou
not have a flat rate contract with your Internedvypder — money for connection time or amount ofadat
transported. In addition, you never can be sulggtwinformation from within your PC is uploadedtte
external server by adware programs. So you hawkedae, which version you prefer. In any case we
recommend to install a personal firewall, whichegiyou control over programs that try to estaldftact

to the Internet.

As to the settings of the DivX codec, there areyrtaipful manuals available in the Internet — $ee t
list of links at the end of this chapter. Howe\ikypu are preparing your videos only for analygi&«QuUAD
(and not for broadcasting them via TV), the setlinfyeady described above are completely sufficedt
satisfying. You should create a folder for eaclewigroject, where you can save the log files writtg DivX
(see above) and keep data form various projectratgul from each other.

As we mentioned already, the DivX codec works twoceeach video file. During the first pass, it
calculates the characteristics of each frame aitdsuhe results in a log-file. During the secpads, these
results are used to optimize the use of memoryimerunit and to produce the final, compressedioarsf
the video. In this process, single frames arstaoed completely, but only information about tiféeedences
between each frame and its predecessor. Thahés) you later want to see the video again, it cabagust
played, but each frame has to be reconstructedloylations based on difference information. Howeve
from time to time (default: every 300 frames), toelec stores a complete frame, the key-frame,adsté
mere difference information. When you navigatetigh a video, for instance by "scrolling" or by joimg
to a particular scene by selecting a specific dod®QuAD, only key-frames can be accessed directly. Of
course, the other frames can be accessed too, kon@\directly but only by computation (= reconstion).

Depending on the speed of your computer, you may $eecome annoyed by breaks between the
selection of a particular scene and the appeamairtbe result on the screen. That is why we recendrto
change the default setting and find a sound ballaeveeen necessary memory space and necessatiyneait
We suggest to set a key-frame twice per secontlistlidout every 3frame. Time-critical analyses such
as for instance the study of mimic behavior may aesreven more key-frames.
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If your WINDOWS applies the FAT32 file administrati, each single file is limited to maximally 2 GB
memory space — a real problem for video analysisvéVer, this limit is not valid in NTFS administdre
systems, that is under WINDOWS NT 4, 2000, and XP.

The internal file administration in VirtualDub alis to connect several files of maximally 2 GB etich
one "logical” file independently of its real, "pligal" size. If you are interested in this featwksase read



about it in one of the tutorials for VirtualDub.oot expect to find this feature in any captudofware.
However, for the initial video you cannot circumvehis limitation, that is, the first capturing run
independently of the type (analog or digital) ofiyeideo — comes to an end after 2 GB, even ifitied,
compressed AVI file will consume much less then 2@&&nory space.

Therefore, you should switch to an NTFS systemoif intend to apply videos. That is, update your
WINDOWS. For video analyses, this is a good idepway, because in WINDOWS 95 some of the
necessary functions are not available, and in WIMEZED98 strange system crashs may happen. They are
probably due to characteristics of the video saféwavhich mostly no longer is tuned to specialdeas of
these old versions of WINDOWS. And a final remdbk not try to run the capturing processes described
here under WINDOWS 3.1 or NT 3.50 — it is impossibl

$ -&
In case your captured video file (see detailed mijetsan in http://mww.100fps.comshows horizontal lines
when you play it again (see details in the sectisiHelp -> Contents -> Video Capture -> Tippsttie help
menu of VirtualDub), you should apply an additiciiiegr while encoding the file in DivX; seleatlditionally

-> Video-> Filters -> Add -> smart deinterlace

and confirm your selection by clicking on "OK." Wnithis filter reduces sharpness of the video toeso
degree, it resolves the problem of interlacing. aAsalternative you could apply the filter setting

-> Video-> Filters -> Add -> deinterlace

"Smart deinterlace" is constructed for video scemérich show a lot of movement and thus changes fro
frame to frame, while "deinterlace" always affeitis complete frame.
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Recently some new developments for storing audidvédeo recordings have become available. Wesptes
here briefly solutions based on "open source" s#vor on freeware products. Thus you can sagasie
fees as for instance for MP3 or the DivX (sharewamsion). Of course, some products are availbke

if you apply them for non-commercial purposes ohlyt these versions are suspected to be "spywdfel'.
the solutions presented subsequently the sour@s@ré available; spy functions would have beesctied
and discussed among users. In addition, accotditggt results published in the journal C'T theropource
codec OGG works better than MP3 in the area of tdviterates (which are sufficient for analysis) and
accomplishes generally files of very good qualiljere, we present and describe the following pnogra
codecs and filters:

* MP3 encoding with LameDrop (software that assisperforming the necessary steps in the production
of MP3 files);

» OGG encoding with OGGDrop (software that assisggirforming the necessary steps in the production
of OGG files; developed by the author of LameDrop);

»  Xvid codec, a video MPEG-4 codec, which is fraeralative for DivX;

» VirtualDubMod, a modified version of VirtualDub,hich allows to open MPEG-2 videos without
converting them with DVD2AVI and VFAPI.

» OGGMux, a software to create a new video wrappent "OGM", which replaces AVI and allows to
structure a video by subtitles and chapters.

We will not repeat here how to handle audio co@eckvideo codecs or the program VirtualDub together
with DivX codecs, but we describe only the newdieas of the tools listed above. The Xvid codecsdus
need further explanation, because the settingalarest the same as for DivX. You can apply it clise
without further considerations. The same is tard/irtualDubMod: if you are familiar with Virtual Db, you
just switch to the modified product.

You get more information about these programs ad@cs and access to download them in the Internet
on the following websites:

Xvid Codec:
http://mww.roeder.goe.net/~koepi/xvid.shtml
http://mww.roeder.goe.net/cgi-bin/fetch?file=XviDEtBeta3-26122003.exe

OGGMux:
http://mww.roeder.goe.net/~koepi/oggmux.htmi
download:http://oggmux.sourceforge.net/

LameDrop:
http://rarewares.hydrogenaudio.org/files/lamedrogx3.3.zip

OGG Homepage:
http://mww.vorbis.com/download_win.psp

OGGDrop&XP
http://download.digitalbyte.de/help/mp3toogg/oggukpd.zip
http://mww.vorbis.com/files/1.0/windows/oggdrop XRih.
http://mww.vorbis.com/files/1.0/windows/oggdrop-\8i&.zip

OGG DS Filter:
http://tobias.everwicked.com/oggds.htm

VirtualDubMod:
http://virtualdubmod.sourceforge.net/



After downloading these programs you have to ihstdl the Xvid codec and the DS filters for OGG,
which you need for playing audio files in OGG fotm@&hese programs come with installation routifies
instance, "setup.exe"), which you start by doubitking on the name. You can accept all the defsttings
without changing anything. All the other prograans simply unpacked into folders and started dirécim
these locations.
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Meanwhile a comfortable software tool "LameDropaisilable, which allows to apply the MP3 encoder
"LAME" simply by "drag'n'drop" operations. That iou start LameDrop, click (within a file manager
environment) on the name of the audio file, whiob want to encode, drag it on the LameDrop wincbap

it there — and a "*.mp3" file is created automdtici the folder of the source file. You find théeftware
tool under

http://rarewares.hydrogenaudio.org/files/lamedrogX3.3.zip

After unpacking the zip-file you can start it wititcadditional installation.

The menu appears, if you move the mouse cursortlid.ameDrop
window and click on the right mouse button. Stgrselecting the quality of
the MP3 file and click on

-> "Encoding Options

This opens the following window:

Here you select the bitrate and the
encoding method, either
CBR = constant bitrate

(preset and recommended) or
VBR = variable bitrate.

A bitrate (see slot "Min. Bitrate") ofl'28'
(kbps) is absolutely sufficient for analyses
in AQUAD.

Confirm your selections by clicking onthe buttoActept"

You drag the files, which you want to
encode, from their directory (keep the
mouse button pressed!) over the LameDrop
icon, drop them there and just wait for the
effects.

A progress bar underneath the icon
shows that the software is encoding your
files.
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The new mp3 file appears in the directory, wheeestburce file is located. The plural formulati¢hs
your files") in this description can be understditetally: It is not necessary to drag and drop @&V file
after the other to LameDrop, but you can mark al@/tist of files and drag'n'drop them togethermesingle
operation.

To get out of LameDrop you press again the rightsadoutton and select the optidxit' or you press
on your keyboard the keys "Alt+F4" together (sespbic on the preceding page).
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As already mentioned above, OGG is a free audimdorof high
quality. Encoding is managed by the program OGG rap the same
author as LameDrop. The details of coping it om tlard disk and
handling it are the same as for LameDrop (see gbove

There is a general version for WINDOWS
http://mww.vorbis.com/files/1.0/windows/oggdrop-\8i&.zip
and a specific version for WINDOWS XP

http://mww.vorbis.com/files/1.0/windows/oggdropXRih.

-> "Encoding Options

give access to determine quality settings
and encoding method (cf. LameDrop). If
you are interested in more details, you find
ample descriptions of the principles of
OGG in the website

http://www.vorbis.com

The drag and drop procedures for selecting
particular files, starting and terminating the
conversion process are the same as already
described in section 4.8.1 (LameDrop).
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Xvid, the open source alternative for DivX, is medile working reliably produces files of good quli
The codec is handled just like DivX. You can fihdnder

http://www.roeder.goe.net/cgi-bin/fetch?file=XviDetBeta3-26122003.exe

VirtualDubMod is a modified version of VirtualDulwhich
gives direct access to MPEG-2 files (it operatéesdintly with
audio streams). You can find it under

http://virtualdubmod.sourceforge.net/

After installing the Xvid codec you start VirtualbMod, open
the file you intend to convert, and select the ssagy filter (for
instance, "resize"). In the codec section youcidlee "Xvid
MPEG-4 Codec".

Here again you have a choice between one-pass (sub-
optimal) and two-pass encoding. We recommend ybat
choose the two pass option.

In the section Advanced optiorisyou find the familiar option to
determine the frequency of key-frames, which isedalMaximum |-
frame interval” in this environment. You set ab8utey-frames per
second, that is, a key-frame every 13-15 frames.

A specific feature is the possibility to
save the MPEG audio-stream iwav"
format. You find this option (see the
button on the right side) in

-> "Stream$ -> "Stream list'
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Afterwards you should delete the audio-stream from
the AVI-file, which we are going to encode, because
later we will convert the exported WAV-file into
OGG format. Click on the buttoiDisable'.

After disabling the audio-stream, the window
changes its appearance:

Now you can save the results of tiephss
operation. Enter a name for the file, but do not
modify any settings.

Alternatively, if you are converting more
than one video file, you may mark the option
"Don't run this job now; add it to batch
control so | can run it in batch mode.

Should you see the video during these operatianspgtter stop
it by marking both Show input videband 'Show output vided
Otherwise you just waste CPU resources and you. tim

Return to the Xvid settings and select now
->"Twopass - 2nd pass

Do not forget (!!) to repeat the setting for kegfres within the
"advanced options" (see 1st pass).
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Then you select an adequate setting for the bi({2@6-
1200 kbps). Experimenting and experiences withXDive
helpful.

The result of the™ pass must be saved in a separate file. If youméted the contents and steps of a
batch procedure (encoding more than one file Bm@)t you start this process now.

Depending on the duration of your videos and thpacties of your PC you will have to wait now until
you can play the final encoded version(s) of yde(s).
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There are other wrapper formats besides AVI, fetance a combination of OGG (audio) and MPEG-4
(video; encoded with Xvid), to put audio and videfmrmation together into one file. In this comaiion,
the resulting files have the extensigrmogm.”

You start by creating an AVI file without sound\ViirtualDub or VirtualDubMod and a separate sound
file in OGGDrop. As results you get two files:

* a video file "*.avi," and
* an audio file "*.0gg."

The software tool for accomplishing the new combtiareis OGGMux. It allows additionally to integrate
subtitles (comments, translations, etc.) in yodew, to structure the file by chapters, to add iséw®und
tracks, and so on. Details are explained in vartatorials and "how to" manuals for "*.ogm" fil&he tool
itself can be downloaded from

http://www.roeder.goe.net/~koepi/oggmux.html

It is not necessary to install OGGMux — after urkiag it can be started from its folder.

The slot labeledMovie" has
to be filled with the name of the
video file that we want to convert.

Correspondingly we enter the name of the "ogg" @fi#i in the sectionSoundtracks Afterwards we
click on the buttonAdd' to initialize and integrate this audio track (sgaphic below).
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After adding a soundtrack, we can select a langubigagine we produce a multi-language video; if we
apply the language option, the user can then séleappropriate language when playing the video.

Finally we enter a file name for our target videedtion QOutput’) and click on the buttonMux File!"
After a short while we get the integrated ".ogmtiiawvideo file.
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Links, howtos, guides, tutorials, downloads:

http://www.doom9.0rg
http://www.vcdhelp.com
http://www.slashcam.de
http://www.DivX-digest.com
http://www.DivXonline.de
http://www.100fps.com

Software mentioned in this chapter:

VirtualDub:
http://www.virtualdub.org

DVD2AVI:
http://arbor.ee.ntu.edu.tw/%7Ejackei/dvd2avi/

HUFFYUV Codec:
http://math.berkeley.edu/~benrg/huffyuv.html

VFAPI Plugin Codec:
http://mwww.yks.ne.jp/~hori/VFAPICodec.html

LAME Win32 Binaries:
http://www.mp3-tech.org/

LAME ACM Codec: (no sublining!)
http://mww.afterdawn.com/software/audio_softwatefio_encoders/lame_acm.cfm

WDM Treiber fir TV Karten:
http://btwincap.sourceforge.net/

Audacity:
http://audacity.sourceforge.net

Graphedit:
Use search engines like doom9 or google

Elecard MPEG-2 DirectShowFilter:
http://www.elecard.com/download/

Xvid Codec:
http://www.roeder.goe.net/~koepi/xvid.shtml
http://www.roeder.goe.net/cqgi-bin/fetch?file=XwD0-Beta3-26122003.exe

OGGMux:
http://www.roeder.goe.net/~koepi/oggmux.html
downloadhttp://oggmux.sourceforge.net/

LameDrop:
http://rarewares.hydrogenaudio.org/files/lamedieg-1.3.3.zip




OGG Homepage:
http://www.vorbis.com/download win.psp

OGGDrop&XP
http://www.vorbis.com/files/1.0/windows/oggdropXRip
http://www.vorbis.com/files/1.0/windows/oggdropas2.zip

OGG DS Filter:
http://tobias.everwicked.com/oggds.htm

VirtualDubMod:
http://virtualdubmod.sourceforge.net/




